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Client System Requirements
The following are some of the client system requirements for iasWorld 2020.1.

Hardware and Platform
The following table displays both CPU and RAM requirements by operating system, as
well as browser and screen resolution requirements.
Operating System
Windows 8

Windows 10

iPadOS/macOS (latest
major release)

Minimum

2.0 x the Microsoft
recommended CPU
requirements

2.0 x the Microsoft
recommended CPU
requirements

As supported by latest major
OS release

Recommended

3.0 x the Microsoft
recommended CPU
requirements

3.0 x the Microsoft
recommended CPU
requirements

As supported by latest major
OS release

Minimum

2.0 x the Microsoft
recommended RAM

2.0 x the Microsoft
recommended RAM

As supported by latest major
OS release

Recommended

3.0 x the Microsoft
recommended RAM

3.0 x the Microsoft
recommended RAM

As supported by latest major
OS release

Minimum

2 GHz x64 processor
2 GB RAM

2 GHz x64 processor

3 GHz x64 processor
4 GB RAM

3 GHz x64 processor

Recommended

CPU

RAM

Examples

Architecture

2 GB RAM

4 GB RAM

The use of the 64-bit versions of the Windows operating system on 64bit
supported workstations is highly recommended. The 32bit versions are
supported, but we recommend using the higher recommendations for CPU and
RAM.
iasWorld 2020.1 supports leading browsers such as Google Chrome, Microsoft
Edge, Apple Safari, and Mozilla Firefox.

Browser

Internet Explorer 11 is required for legacy modules including Field, Respond,
Analyze, and Analyze Lite, or when Apex is being used as a sketch provider. A
small set of administration pages also require Internet Explorer 11; iasWorld
2020.1 and subsequent versions will be updated to support these pages in
leading browsers within six months of iasWorld 2020.1’s initial release.
Note: Microsoft Edge support is limited to versions 78 or above, which are
based on Chromium. Earlier versions of Edge are not supported.

Screen Resolution

iasWorld is designed for use on client workstations with a screen resolution of at
least 1366x768, but a screen resolution of 1920x1080 or higher is preferable.
Resolutions lower than 1366x768 are not supported.
The use of multiple monitors is beneficial and can increase productivity.
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Note: This documentation does not include requirements for other applications that may
be integrated with the iasWorld system. For any third-party integration components
outside of iasWorld, you must reference the specific requirements provided by that
application.

Report File Viewer
iasWorld reports are generated in a PDF file format. To view these reports, a PDF viewer
application is required. Tyler Technologies recommends the most recent version of
Adobe Reader, but any compliant PDF viewer will suffice. Leading browsers are also
capable of viewing PDF files within the browser, but Adobe Reader provides a richer user
experience.

April 2020

Tyler Appraisal & Property Tax Solutions

2

Client Workstation Configuration

Client Workstation Requirements

Client Workstation Configuration
The following sections provide guidance on browser configuration with a focus on items
that can affect iasWorld’s performance and functionality.

Adjusting Browser Settings
All web browsers have a screen or dialog that allows to adjust settings. The location of
the settings screen or dialog varies by browser:
•

In Google Chrome, settings are accessed via the menu button
Settings.

•

In Microsoft Edge, settings are accessed via the menu button
Settings.
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Note: If your settings screen displays as a toolbar on the right site of the browser,
then you are using an outdated version of Microsoft Edge and an upgrade to the
latest version is required.
Previous Edge Settings Screen

Current Edge Settings Screen
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In Microsoft Internet Explorer, settings are accessed by clicking the menu button
and choosing Internet Options.

•

In Mozilla Firefox, settings are accessed via the menu button
Options.

•

In Apple Safari on macOS, settings are accessed by pulling down the Safari
menu item and choosing Preferences.

•

In Apple Safari on iPadOS, settings are accessed by opening the Settings app
and going to the Safari subsection.

and choosing

The settings screens in leading browsers generally have search facilities that aid in
finding specific settings. Simply enter the phrase you are searching for into the search
box (such as “Cache”) and the browser will show you any related settings.
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Requiring HTTPS
Most leading browsers now flag sites not using HTTPS as “insecure” in the address bar.
If iasWorld is not configured to use HTTPS, users should be told to expect the “insecure”
notice.
•

Internet Explorer does not flag sites that do not use HTTPS. However, HTTPS
can be required if iasWorld is placed in the Internet Explorer Trusted Site zone,
and then checking the Require server verification (https:) for all sites in this
zone checkbox.

Enabling Downloads
Certain features in iasWorld allow the users to download files. For these features to work,
file downloads need to be enabled within the browser.
•

In leading browsers, downloads are always generally allowed. These browsers
typically have options in their Settings that allow users to control the folder
downloaded to, or to force the browser to ask for a location when downloading.

•

In Safari, after a download is triggered, users will typically be asked if they want
to allow the download to occur.

•

In Internet Explorer, downloads can be enabled or disabled using the Security
tab by clicking on Custom Level. This opens a Security Settings dialog, with
“File download” as an option that can be enabled or disabled.

Browser Caching
Web browsers cache previously downloaded files for future use. The purpose of this file
caching process is to increase site performance on subsequent visits to a site because
some previously downloaded files may be able to be reused.
•

Leading browsers manage the size of their cache automatically, adjusting it to fit
available disk space. No manual settings are required, though users can clear
their cache if they are trying to free up disk space.

•

In Internet Explorer, cached files are known as Temporary Internet Files.
Temporary Internet Files can be enabled in the Internet Options dialog, going to
the General tab, and clicking the Settings button.
The frequency of checking for newer versions of stored files should be set to
“Automatically” (the default value). The disk space allocated to temporary Internet
files should be at least 50 MB (the default value is usually greater than 50 MB).
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Cookies
Web applications utilize cookies – small pieces of text carried along with requests from a
web browser to the server and the response from the server – to preserve information
across all requests. Cookies are essential to iasWorld’s operation, used for the following
purposes:
•

Session authorization (keeping users logged in)

•

Security checks (anti-cross site request forgery protection and session fixation)

•

Minor miscellaneous short-term data storage.

Web browsers generally contain options to disable cookies, and if they are disabled,
iasWorld will not operate properly. While all browsers enable cookies by default, if a user
has disabled cookies, they will need to be re-enabled.
There are two general types of cookies – first-party cookies, which are provided by the
server hosting the web application, and third-party cookies, which are provided by other
servers providing secondary features (frequently related to advertising and tracking).
iasWorld does not use third party cookies, and so the features in leading browsers to
disable third-party cookies will not affect iasWorld.
•

In Chrome Settings, cookies can be enabled by enabling Privacy and Security |
Site Settings | Cookies and site data | Allow sites to save and read cookie
data.

•

In Edge Settings, cookies can be enabled by enabling Site Permissions |
Cookies and Site Data | Allow sites to save and read cookie data.

•

In Firefox Options, cookies can be enabled by going to the Privacy & Security
section and choosing Standard or Strict tracking protection. If using Custom
protection, make sure the Cookies section is set to any option other than All
Cookies.

•

In Safari Preferences, cookies can be enabled by going to the Privacy tab and
ensuring Block all cookies is not set.

•

In Internet Explorer Internet Options, cookies can be enabled by going to the
Privacy tab, clicking Advanced, and ensuring that First Party Cookies is set to
Accept and Allows allow session cookies is checked. You may also need to
click the Sites button on the Privacy tab and make sure that the iasWorld URL is
either not listed, or is listed and set to Allow.
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JavaScript
iasWorld depends heavily on JavaScript scripting to operate correctly. This is a
programming language within the browser that has the ability to control the user interface
and other features of the application. If JavaScript is disabled, iasWorld will not work
correctly.
•

In Chrome Settings, JavaScript can be enabled by setting Privacy and Security
| Site Settings | JavaScript to Allowed.

•

In Edge Settings, JavaScript can be enabled by setting Site Permissions |
JavaScript to Allowed.

•

In Firefox Options, JavaScript cannot be disabled.

•

In Safari Preferences, JavaScript can be enabled by going to the Security tab
and ensuring Enable JavaScript is set.

•

In Internet Explorer Internet Options, JavaScript can be enabled by going to the
Security tab, clicking Custom Level, and that the following options are set:
Script Option

April 2020

Setting

Binary and Script Behaviors

Enable

Script ActiveX controls marked safe for scripting

Enable

Active Scripting

Enable

Allow status bar updates via script

Enable

Allow websites to prompt for information using scripted windows

Enable

Scripting of Java applets

Enable

Allow programmatic clipboard access
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Mixed Content
In iasWorld, maps and other content are typically hosted within iframes contained within
iasWorld pages. These iframes are loaded via separate requests and can be accessed
via different protocols than iasWorld itself is using.
When iasWorld is configured to be accessed via HTTPS and the hosted content is not
configured to be accessed via HTTPS, the resulting “mixed content” configuration can
pose a security concern and will therefore generally be blocked by default by the browser.
In normal usage, mixed content should not be allowed. Instead, the hosted map or other
content should be updated so that it can also be accessed via HTTPS. However, it can
occasionally be useful as a troubleshooting mechanism to enable mixed content support
in a browser.
•

In Chrome Settings, mixed content can be enabled by going to Privacy and
Security | Site Settings | Insecure Content and adding the iasWorld URL as an
exception.

•

Microsoft Edge does not support mixed content.

•

In Firefox, mixed content can be unblocked by clicking on the lock
the address bar and choosing Disable Protection for now.

•

Safari does not support mixed content.

•

In Internet Explorer Internet Options, mixed content can be allowed by going to
the Security tab, clicking Custom Level, and then enabling Display Mixed
Content in the list.
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Pop-up Blockers
Web browsers have pop-up blockers to prevent unwanted and annoying pop-up windows
from being opened. Browsers use a set of rules to determine when a window being
opened is treated as a pop-up and when it isn’t. In general, windows that are opened as a
direct result of a user clicking on a link will not be treated as pop-ups, but exceptions can
occur.
iasWorld can open modules in secondary windows, and those actions might be treated by
a browser as a pop up. The result would be that the iasWorld module would not open. To
avoid this, we recommend disabling pop up blocking in the browser, at least for iasWorld.
•

In Chrome Settings, pop up blocking can be disabled can be going to Privacy
and Security | Site Settings | Pop-ups and redirects and adding the iasWorld
URL as an allowed site.

•

In Edge Settings, pop up blocking can be disabled can be going Site
Permissions | Pop-ups and redirects and adding the iasWorld URL as an
allowed site.

•

In Firefox Options, pop up blocking can be disabled by going to Privacy &
Security | Permissions and either disabling Block pop-up windows or adding
iasWorld as an allowed site.

•

In Safari Preferences, pop up blocking can be disabled by going to iasWorld
before opening Preferences, then going to the Websites tab and choosing
Popup Windows. IasWorld will appear in the list, and the setting for iasWorld can
be changed to Allow.

•

In Internet Explorer Internet Options, pop up blocking can be disabled by going
to the Privacy tab and unchecking Pop-up Blocker.
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User Interface Settings
Web browsers generally offer settings that allow you to change the appearance of pages
within the browser. These settings often include changing font sizes, changing default
fonts used in cases where no other font is specified, and overall page zoom.
These settings can cause significant changes to the appearance of the iasWorld user
interface, and as result, changes to some settings are not supported by iasWorld.
Default font settings will not affect iasWorld, as iasWorld always specifies specific fonts to
use.

Browser Text Size
Browsers allow users to set a default relative font size for web pages. However, this is a
historically older feature that provides an incomplete solution to readability. Using this
functionality can affect page layout because other page elements such as images are not
affected by the text size change. Instead, customers wanting to improve readability for
accessibility reasons should use the browser’s page zoom feature.
•

In Chrome Settings, text size can be reset by setting Appearance | Font size to
Medium.

•

In Edge Settings, text size can be reset by setting Appearance | Font size to
Medium.

•

Firefox does not provide a relative text size option. However, Fonts and Colors
has an Advanced button, and in the dialog that shows when you click Advanced,
Allow pages to choose their own fonts, instead of your selections above
should always be selected.

•

Safari does not provide a relative text size option.

•

In Internet Explorer, the text size can be reset to by choosing the View menu (you
may need to press the Alt key to make it visible), choosing Text Size, and
Medium.

Browser Text Encoding
Some browsers allow users to set a text encoding for web pages. This used to correctly
render older localized pages that do not provide details on the text encoding they use.
The encoding should not be changed for iasWorld.
•
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In Internet Explorer, the encoding can be reset to by choosing the View menu
(you may need to press the Alt key to make it visible), choosing Encoding, and
UTF-8.

Color and Font Settings
Some browsers support the ability to ignore or override font or color choices supplied by
web page for accessibility reasons. Typically, this allows users to supply a higher-contrast
color scheme that is easier to read.
iasWorld 2020.1 utilizes a high contrast color scheme, and as such, overriding the
standard page styles will reduce readability, not enhance it. For this reason, users should
not override font or color settings.
•

In Chrome, colors can only be overridden via the addition of a color-adjusting
accessibility extension. To ensure that colors are not overridden, go to the menu
and choose Extensions, and review the installed extensions to ensure that none
are affecting colors. You may wish to temporarily disable all extensions as a test.

•

In Edge, colors can only be overridden via the addition of a color-adjusting
accessibility extension. To ensure that colors are not overridden, go to the menu
and choose Extensions, and review the installed extensions to ensure that none
are affecting colors. You may wish to temporarily disable all extensions as a test.

•

In Firefox Options, styles can be rest by going to Fonts and Colors, clicking
Colors, and ensuring that Override the colors specified by the page with our
selections above is set to Never.

•

In Safari Preferences, go to the Advanced tab and ensure that Style Sheet is set
to None Selected.

•

In Internet Explorer Internet Options, styles can be reset by clicking the General
tab and then clicking the Accessibility button. In the dialog that results, ensure all
checkboxes are clear.
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Third Party Browser Add-ons and Extensions
Browsers support the addition of additional features via add-ons and extensions. Add-ons
are a historic compiled-code approach to adding functionality to browsers, while
extensions are a lighter-weight JavaScript-based approach.
For Internet Explorer, iasWorld does not require and does not support third-party browser
addons being installed. Existing add-ons should be removed to ensure that they do not
interfere with iasWorld’s operation.
For leading browsers, iasWorld does not require any extensions be added, and we do not
recommend any specific extensions be installed. Extensions should only be installed if
they are approved by the organization’s IT department.
Some extensions or add-ons modify the displayed content of pages, and this can create
functional problems in iasWorld. Tyler is not responsible for any functional problems
caused by add-ons or extensions.
Should functional problems be seen in iasWorld, disabling any extensions or add-ons
should be considered as an essential early step in troubleshooting.
•

In Google Chrome, extensions are managed via the menu button
choosing Settings.

•

In Microsoft Edge, extensions are managed via the menu button
choosing Extensions.

•

In Microsoft Internet Explorer, add-ons are managed by clicking the menu button

and

and

and choosing Internet Options. Within the Options dialog, click on the
Programs tab and then Manage Add-ons.
•

In Mozilla Firefox, extensions are managed via the menu button
choosing Add-ons.

•

In Apple Safari on macOS, extensions are managed by going to Preferences
and clicking on the Extensions tab. Note that extensions are added by installing
a supporting application via the Mac App Store.

•

In Apple Safari on iPadOS, extensions are disabled by clicking on the Share

and

button
within Safari and tapping either More or Edit Actions, depending on
which section of the Share sheet the extension appears.
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AutoComplete
Internet Explorer supports the ability for the browser to retain information in its cache files
for values that have been typed into fields on a form. Subsequent navigation to a field on
a form with the same field name provides you with the option of selecting a previously
typed value for the field from a list. This functionality is known as AutoComplete.
AutoComplete should be disabled for iasWorld use in order to prevent fields from being
filled with incorrect data.
Other browsers have fill features that are specific to passwords and addresses and
should be less likely to interfere with data entry. Should a problem occur, they can also
be disabled.
•

In Chrome Settings, form filling can be disabled can be disabling Autofill |
Addresses | Save and fill addresses.

•

In Edge Settings, form filling can be disabled can be disabling Autofill/Addresses
and more/save and fill addresses.

•

In Firefox Options, form filling can be disabled by going to Privacy & Security |
Forms and Autofill and disabling Autofill addresses.

•

In Safari Preferences, form filling can be disabled by going to the Autofill tab and
disabling Other forms.

April 2020

Tyler Appraisal & Property Tax Solutions

14

Additional Settings

Client Workstation Requirements

Additional Settings
Browsers offer additional settings that can affect the functioning of iasWorld.

Google Chrome
The following settings should be set to the values shown. To access them, search for
them via the Search Settings box.
Item
Use hardware acceleration when available

Setting
Checked

Microsoft Edge
The following settings should be set to the values shown. To access them, search for
them via the Search Settings box.
Item
Use hardware acceleration when available

Setting
Checked

Mozilla Firefox
The following settings should be set to the values shown. To access them, search for
them via the Find in Options box.
Item

Setting

Applications (controls whether to open file types in applications other than
the application registered with Windows for the file type)

As desired

Use recommended performance settings

Checked

Internet Explorer
The following Advanced Settings must be set to the values shown. To access them,
from Internet Explorer Internet Options, select the Advanced tab.
Internet Explorer offers a wide array of configuration settings that it designates Advanced
Settings. For iasWorld to function properly on a client workstation, the client workstation
must have the following default Advanced Settings enabled.
Item

Setting

Enable visual styles on buttons and controls in web pages

Checked

Use HTTP 1.1

Checked
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Item

Setting

Show Pictures

Checked

Enable native XMLHTTP Support

Checked

April 2020

Tyler Appraisal & Property Tax Solutions

16

Additional Considerations

Client Workstation Requirements

Additional Considerations
The following are some additional items to consider when configuring your workstation.

Browser Zoom Levels
Browsers provide the ability for you to specify a “zoom level” for viewing web pages.
Zoom Levels increase the scale of web pages displayed in the browser by magnifying all
elements on a page. In doing so, they preserve the page layout, but as the magnification
level increases, the amount of information displayed necessarily decreases until the page
no longer is rendered in a useful way.
We recommend zoom levels be kept at 100% unless they are being increased for
accessibility reasons.

Tabbed Browsing
Most browsers support opening of new pages in either tabs or new windows, based on
user preference. There is no functional difference between these two approaches, and
iasWorld supports either choice.
.
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